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Release Notes           

Browsium Catalyst 4.4  
Product Version: 4.4.0 

Release Notes Updated: 26 November 2017 

 

About this Release 

This document lists new features, known issues, and potential incompatibilities as of the release date. If you discover an 

issue, please review the Known Issues list below to determine if it has already been documented. If the issue is not 

referenced, please visit the Browsium Support website for troubleshooting tips, product documentation, and the option to 

submit support tickets. 

What is Catalyst 
Browsium Catalyst is a multi-browser web traffic manager for the enterprise, enabling IT to pair all web applications with 

the most compatible and secure browser on every PC in the organization.  

What’s New in this Release 
This section of the release notes is reserved for notable changes and new features since the prior version.  

What’s new in Catalyst 4.4 

This section details changes to Catalyst since the prior version, Catalyst 4.3.1 

• Adds support for Microsoft Edge. 

o Edge support requires systems be domain joined and side loading extensions enabled. 

• Adds support for 64-bit Firefox.  

 

 

  

https://www.browsium.com/support/
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Minimum System Requirements 

Operating System 
Windows 7 or later 

Windows Server 2008 R2 or later (for multi-user terminal servers) 

Browsers 

Microsoft Internet Explorer 8, 9, 10, or 11 

Microsoft Edge 40 or later 

Google Chrome 39 or later 

Mozilla Firefox 52 or later (41 or later with Browsium legacy extension) 

.NET Framework Version 3.5 SP1 or later (full version only) 

Processor 1 GHz 32-bit (x86) or 64-bit (x64) processor 

Memory 1GB total system RAM; 2GB for multi-user terminal servers 

 

 

Installing and Using This Release 

 

• You must install both Browsium Client (Browsium-ClientSetup.exe) and Catalyst Configuration Manager (Catalyst-

Setup.exe) to develop Catalyst projects. End user PCs require only Browsium Client.  

• It’s a good practice to close browser windows, and associated processes, before installing Browsium Client. If 

browser windows are open, Browsium Client installer will close the windows and processes automatically, which 

may result in a warning message the next time the browser is launched. This warning message can be ignored. 

Enterprise deployments to end user PCs should be scripted to install at night or immediately following a reboot. 

• Catalyst 4.4 cannot read projects created with Catalyst 1.x or 2.x. These projects must be recreated from scratch 

using Catalyst Configuration Manager. Catalyst 4.4 will read projects created with Catalyst 3. x. Catalyst 

Configuration Manager will upgrade these projects to the Catalyst 4.x format. 

• Install Browsium Client in the 30-day evaluation mode by leaving the Catalyst License Key field blank on the 

“Client Configuration” screen during setup, unless Browsium has already provided you with a Catalyst license key. 

• Catalyst Configuration Manager 4.4 cannot be installed if Ion Configuration Manager 3.x is already installed on the 

system. You must first uninstall Ion Configuration Manager 3.x. Upgrading Catalyst Configuration Manager 3.x to 

4.4 is supported if Ion Configuration Manager 3.x is not present on the system. 

• If you're also using Browsium Ion, you'll need to install Ion Configuration Manager 4.4 to run it on the same 

system as Catalyst Configuration Manager 4.4. 

• If using Catalyst on Windows 8 or Windows 10, you will need to manually set Catalyst as the default browser in the 

Default Programs control panel or when prompted. For enterprise deployment, it’s recommended that you control 

this setting via Group Policy. 

• Read the Catalyst Administration Guide for more information on installing and using Browsium Catalyst. 

  

http://docs.browsium.com/guide/?v=4.4.0&p=Catalyst
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Known Issues 
 

• Edge browser shows a "spinning dots" loading webpage when Catalyst redirects a web page out of Edge browser 

using "Same page" target action 

• Catalyst’s "close tab" starting action does not work on domain-joined PCs running IE8 because IE8 blocks scripts 

from running. The close.html page will appear and stay open in this case. This issue will not interfere with the 

proper function of any web applications. 

• Links and web documents on the file system use a custom icon provided by Catalyst, when Catalyst set to be the 

default HTTP and HTTPS handler. On Windows XP, they use the icon of the last default browser before Catalyst 

was installed.  

• Catalyst silently ignores the rules that have same Starting Browser and Target Browser value, regardless of other 

options selected for the rule.   

• Catalyst is disabled by default for Internet Explorer’s InPrivate mode and Chrome’s Incognito mode. Catalyst can 

be enabled manually for these modes.  

• The command to auto-enable the Catalyst Firefox extension, as documented in the Catalyst Admin Guide, may fail 

if multiple Firefox profiles are present on the system. 

• When Project->Project Settings->Override Default Browser is enabled, the default browser may show a warning 

that it is not the default browser on the system. For Catalyst to be able to evaluate rules from non-browser 

applications, please select “Don’t ask again” option in Internet Explorer, Firefox and Chrome browsers. These 

settings can be managed by Group Policy in an enterprise deployment. 

• When Project-> Project Settings-> Override Default Browser is disabled, Internet shortcuts may fail to comply with 

Catalyst rules if the default browser defined in Windows Default Programs is not already running when the link is 

clicked. To avoid this issue, it is recommended that you set Override Default Browser to Enabled, and manage the 

default browser setting via the Catalyst configuration. 

• Catalyst cannot execute a rule against the homepage for Firefox. The homepage will load regardless of Catalyst 

settings. In general, it is not recommended to set Catalyst rules for URLs that are also set as browser homepages. 

• Setting a rule to open google.com in Internet Explorer can cause unpredictable behavior when using the New Tab 

button or searching via Chrome’s address bar. The New Tab page and address bar searches in Chrome include 

references to google.com that can trigger redirection to Internet Explorer. To avoid this issue, always use Chrome 

for Google sites if using Chrome for any sites, or create a rule with Target Browser = Any for google.com. 

• Catalyst does not support Custom zones in Internet Explorer.  

• When a browser has Block Other Requests enabled, it will not evaluate rules unless those rules have a Starting 

Browser set to Any. A rule with the Starting Browser set to a specific browser and the Target Browser set to a 

browser with Block Other Requests enabled may cause a looping condition and should be avoided. 

• Browsium Controller is not launched in developer mode when started (or restarted) from the Utilities menu within 

Catalyst Configuration Manager. Therefore, neither Splash Screen nor the Windows 8+ (and Windows Server 2012) 

default browser picker dialog will be shown when Controller is started. The Controller is started in developer mode 

when choosing Start Test Configuration from the File menu. 

• When redirecting between browsers via Catalyst rules, the Starting Browser may navigate to a blank page, 

navigate back one page in the browser history, or close the tab entirely if the navigation crosses between Internet 

Explorer zones. This is due to an issue with how Internet Explorer exposes its history to Browser Helper Objects. 

This issue should not interfere with the proper function of any web applications. 
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Contact 
 

For technical support, please visit the Browsium Support website.  

https://www.browsium.com/support/
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What’s New in Prior Releases 
 

What’s new in Catalyst 4.3.1 

This section details changes to Catalyst since the prior version, Catalyst 4.3. 

• Fixes a bug in Browsium Client Internet Explorer Extension so that it now properly registers itself as compatible 

with Internet Explorer Enhanced Protected Mode on Windows 8 and later. 

 

What’s new in Catalyst 4.3 

This section details changes to Catalyst since the prior version, Catalyst 4.2.4. 

• Fixes an issue in Catalyst where certain Any to Any rules weren't being processed correctly. 

• Fixes an issue in Catalyst where desktop shortcuts that result in being processed with Any to Any rules were not 

resulting in a navigation. 

• Adds additional logging for Catalyst rule processing. 

• Fixes an issue where websites that relied on an overridden window.onLoad function were failing to render 

correctly in Firefox and Chrome when the Browsium Client extension was enabled. 

 

The four changes above only available in build 4.3.0.286, slipstreamed into Catalyst release channel on 5 June 2017. 

 

• Updated Firefox extension uses new WebExtensions model for better performance and reliability. 

• Other behind-the-scenes bug fixes to improve Catalyst reliability on complex enterprise networks. 

 

What’s new in Catalyst 4.2.4 

This section details changes to Catalyst since the prior version, Catalyst 4.2.3. 

• There are no changes to Catalyst functionality in the 4.2.4 release. 

• Changes to Ion 4.2.4 necessitate deployment of Browsium Client 4.2.4, which in turn requires Catalyst 

Configuration Manager 4.2.4. Therefore, Catalyst customers using Ion 4.2.4 should also deploy Catalyst 4.2.4. 

 

What’s new in Catalyst 4.2.3 

This section details changes to Catalyst since the prior version, Catalyst 4.2.2. 

• Fixes a compatibility issue in the Browsium Internet Explorer Extension that could cause certain older ActiveX 

controls to crash when closing an Internet Explorer window. 

 

What’s new in Catalyst 4.2.2 

This section details changes to Catalyst since the prior version, Catalyst 4.2.1. 

• There are no changes to Catalyst functionality in the 4.2.2 release. 

• Changes to Ion 4.2.2 necessitate deployment of Browsium Client 4.2.2, which in turn requires Catalyst 

Configuration Manager 4.2.2. Therefore, Catalyst customers using Ion 4.2.2 should also deploy Catalyst 4.2.2. 

 

What’s new in Catalyst 4.2.1 

This section details changes to Catalyst since the prior version, Catalyst 4.2. 
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• There are no changes to Catalyst functionality in the 4.2.1 release. 

• Changes to Ion 4.2.1 necessitate deployment of Browsium Client 4.2.1, which in turn requires Catalyst 

Configuration Manager 4.2.1. Therefore, customers using Ion 4.2.1 should also deploy Catalyst 4.2.1.  

 

What’s new in Catalyst 4.2 

This section details changes to Catalyst since the prior version, Catalyst 4.1.1. 

• Adds "find" functionality to the Catalyst Manager. 

• Adds the ability to export Catalyst rules to CSV 

• Adds the ability to define a batch file as a custom browser in Catalyst. 

• Improves client startup performance when some modules are inactive. 

• Adds a notification area to Catalyst Manager to notify when project update activation has reloaded a project. 

• Adds support for multi-process Firefox which is planned to become the default operating mode in Firefox 51 and 

later. 

 

What’s new in Catalyst 4.1.1 

This section details changes to Catalyst since the prior version, Catalyst 4.1. 

• Fixes an issue with Catalyst on Windows 10 where an infinite redirect loop could occur if hopping across security 

zones originating with a site that contains a JavaScript-based redirect. 

 

What’s new in Catalyst 4.1 

This section details changes to Catalyst since the prior version, Catalyst 4.0.1. 

• Adds the ability to create new rules at any location in the Rules Manager list in Catalyst Configuration Manager. 

• Adds the ability to handle file:// protocol redirects between browsers. 

• Combines the splash screens for all modules into a single splash screen displaying configuration information for 

each module. 

• General improvements to Browsium Client in the areas of stabilization, robustness, and performance. 

• Fixes a bug that allowed Catalyst Configuration Manager to launch URLs while elevated. 

• Fixes a bug that caused Catalyst to corrupt some case-sensitive URLs on redirect. 

• Fixes a bug that blocked new tab navigations when the Internet Explorer window has no tabs. 

• Fixes a bug that caused Browsium Controller to crash on some systems while displaying the splash screen. 

 

What’s new in Catalyst 4.0.1 

This section details changes to Catalyst since the prior version, Catalyst 4.0. 

• Fixes an issue that causes case-sensitive URLs invoked from outside a browser to be changed to lower case when 

Catalyst is set as the default browser. 

• If you're also using Browsium Ion, you'll need to install Ion Configuration Manager 4.0.1 to run it on the same 

system as Catalyst Configuration Manager 4.0.1. 

 

What’s new in Catalyst 4.0 

This section details changes to Catalyst since the prior version, Catalyst 3.2. 
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• The new, unified Browsium Client includes the agent functionality for Proton, Ion, and Catalyst, resulting in a 

simple client deployment that works with all modules in the Browsium browser management suite. 

o Browsium Client includes browser extensions for Internet Explorer, Chrome, and Firefox. 

o Browsium Client installs a new Browsium Service (BrowsiumService.exe) to handle client operations that require 

administrative privileges at runtime. 

o Browsium Controller (BrowsiumController.exe) and Browsium Monitor (BrowsiumMonitor.exe) replace Browsium 

Catalyst Controller (BrowsiumCatalystController.exe) and Browsium Catalyst Monitor (BrowsiumCatalystMonitor.exe) from 

prior versions. These new processes provide functionality for Ion, Catalyst, and Proton if configured, reducing 

the overall memory footprint and number of processes required to run the Browsium suite. 

• Adds support for ‘Starts With’ rule matching to provide more granular targeting of websites that require browser 

redirection. 

• Adds support for Enhanced Protected Mode in Internet Explorer. The Browsium Client Extension for Internet 

Explorer is now 64-bit compatible, so Catalyst can run in 64-bit Internet Explorer tab processes.  

 

What’s new in Catalyst 3.2: 

This section details changes to Catalyst since the prior version, Catalyst 3.1.2. 

• New Project Update Activation feature improves configuration deployment by enabling on-the-fly and scheduled 

configuration updates on clients without restarting the Catalyst Controller. 

• Catalyst now supports rule evaluation within browsers that have been launched "as administrator".  

• The default browser selected within Catalyst now handles invoking "Search Online" from within the Windows Task 

Manager, and similar utilities. The search will be launched inside the default browser in the Catalyst configuration.  

• Fixes a bug in Catalyst default browser handler to successfully launch Visual Studio web debugger. 

• Fixes a bug that affects Regex rules with some special options.  

• Fixes a bug in Catalyst Internet Explorer Add-on to avoid a navigation error that results in a blank page with the 

URL http:/// on certain rule evaluations. 

 

What’s new in Catalyst 3.1.2: 

This section details changes to Catalyst since the prior version, Catalyst 3.1.1. 

• Includes a new Catalyst Extension for Firefox (version 3.2.0.58) which is signed by Mozilla and compatible with the 

current Firefox release 44 (and later) which requires signed extensions.  

• Fixes a crash in BrowsiumCatalystLauncher.exe when opening new links from third party applications. 

• Fixes a crash in the Enable Firefox Extension registry action when there are empty Firefox profiles on the system. 

 

What’s new in Catalyst 3.1.1: 

This section details changes to Catalyst since the prior version, Catalyst 3.1. 

• Fixes a transport layer bug that caused the Catalyst Controller to hang when non ASCII characters are present in a 

URL.  

• Fixes a bug in the Catalyst Chrome extension when evaluating a rule on a URL that opens in a new window. 

• Fixes a bug in the Catalyst Chrome extension when evaluating a zone rule. 

 

What’s new in Catalyst 3.1: 

This section details changes to Catalyst since the prior version, Catalyst 3.0.1. 

• Adds support for Windows 10 (IE11, Chrome, and Firefox only; Catalyst does not work with the Edge browser 

which has no extension model).  
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• Fixes an issue in the Catalyst Chrome extension which causes the Chrome back button to loop between the 

current and next most recent URL. 

• Improves the experience in Chrome for websites with 302-redirected traffic. 

• Fixes in issue which causes Catalyst to fail to run properly on the Turkish version of Windows. 

 

What’s new in Catalyst 3.0.1: 

• Fixes an issue which causes Catalyst to fail to bring minimized browser windows into focus when executing a 

browser redirection. 

• Fixes an issue which causes Catalyst to fail to properly redirect links from within Microsoft Outlook. 

• Improves “Same Page” starting action experience for Internet Explorer when the navigation causes a zone switch.  

• Adds an advanced custom Catalyst preference that allows Catalyst to evaluate rules on 302 redirected traffic.  

• Fixes an issue in rule evaluation when very long URLs are used.  

• Fixes a rare race condition in Catalyst controller that could cause it to stop evaluating rules.  

 

What’s new in Catalyst 3.0.0: 

• New Catalyst Configuration Manager, based on Ion Configuration Manager, delivering consistent experience, 

improved speed, and enabling more rapid addition of new features. 

• Copy/paste rules within and between projects for faster configuration development. 

• Improved configuration testing functionality uses XML files instead of serialized registry entries, with automatic 

saving of project files and simplified menu options – consistent with Ion. 

• Logging to Event Viewer for both Catalyst Configuration Manager and Catalyst Client. 

• Renamed Catalyst Configuration Manager installer to Catalyst-ManagerSetup.msi (from Catalyst-AdminSetup.msi 

in prior versions). 

• Added Splash Screen that is displayed on Controller start, but defaults to ‘Disabled’ in Project Settings. Splash 

Screen is always shown if Controller is started via Start Test Configuration. 

• Simplified configuration hierarchy, based on XML-formatted project files, to ease deployment. (Note, Catalyst 3 is 

not compatible with Catalyst 2 project files.) 

• New ADM/ADMX templates for easy Group Policy deployment of configuration file pointers are available from the 

Catalyst Knowledge Base. 

• Updated the command-line switch that displays registry and file location of active Catalyst configuration, now via 

the command “BrowsiumCatalystController /WhichConfig”.  

• Added a new capability to show WhichConfig results and .NET CLR version by pressing ‘Ctrl’ while displaying the 

Catalyst Configuration Manager About Box. 

• Improved robustness to handle scenarios where browser processes start before Catalyst Controller after PC reboot 

• Configuration caching to enable offline Catalyst process initialization when deploying project file on a server. 

• New configuration option to set Target Browser = Any, allowing specific sites to open in any browser, even when 

Block Other Requests is enabled. 

• Support for defining Chrome Application Mode (Chrome with no menus or address bar) as a custom browser, with 

rule evaluation to and from Chrome Application Mode. 

• New asynchronous Chrome extension runs as standalone Windows process for greater robustness. 

• Support for high DPI monitors enables project development at any screen resolution. 

• Catalyst process names have been updated to be more consistent and more easily identified: 

Prior  Current 

ManagerUI.exe  BrowsiumCatalystManager.exe 

Controller.exe  BrowsiumCatalystController.exe 

CatalystMonitor.exe  BrowsiumCatalystMonitor.exe 

 

What’s new in Catalyst 2.0.2: 

http://www.browsium.com/faqs/browsium-adm-admx-templates-ion-catalysthttp:/www.browsium.com/faqs/browsium-adm-admx-templates-ion-catalyst
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• Fixes an issue that blocked Catalyst Controller from starting when no network connection is available. 

What’s new in Catalyst 2.0.1: 

• Improves Chrome window focus after redirection from Internet Explorer to Chrome. 

• Fixes an issue that blocked Catalyst Controller from starting on non-English versions of Windows XP. 

• Support for alpha-numeric license keys. 

What’s new in Catalyst 2.0: 

• Support for Windows 8.1 with IE11, and IE11 on Windows 7. 

• Support for bi-directional redirection of URLs between native Internet Explorer, Chrome, and Firefox and virtual IE 

using Citrix XenApp. 

• Support for bi-directional redirection of URLs between native Internet Explorer, Chrome and Firefox and virtual IE 

using VMware ThinApp. 

• New command-line switch displays active Catalyst configuration via the command “Controller /WhichConfig”.  

• Integrated setup allows choice of license key or 30-day evaluation during installation of Catalyst Client. 

• Fixes an issue where custom browser paths did not automatically insert a trailing slash when exporting projects to 

ADM or ADMX files. 

• Fixes an issue where navigation between zones caused a blank page or redirection message in Internet Explorer 

when the desired Starting Browser action is Same Page. 

 

 

 

What’s new in Catalyst 1.0.3: 

• Windows Server 2003 and Windows Server 2008 are now supported operating system platforms. 

• Fixes a port conflict bug in multi-user environments. The prior release did not work properly when two users 

running the Catalyst Client were logged into the same multi-user server with Remote Desktop Services or Citrix. 

• Includes new versions of both Catalyst Client and Catalyst Configuration Manager. On systems running Catalyst 

1.0.2 or older, the older components must be uninstalled from Add/Remove Programs before installing 1.0.3. 

What’s new in Catalyst 1.0.2: 

• Fixes an issue where desktop shortcuts and URLs accessed from the Run command opened slowly and generated 

an error message on PCs running Windows XP where Catalyst had taken over as the default browser from Internet 

Explorer. Catalyst properly takes over as the default browser now. 

• Fixes an issue where Catalyst did not properly return Internet Explorer as default browser on Windows 7 when 

"Clearing Local Settings" in the Catalyst Configuration Manager. Catalyst properly returns Internet Explorer as the 

default browser now. 

• Improves the user experience for IT admins when adding a custom browser in the Catalyst Configuration 

Manager. Prior versions of Catalyst failed to work properly without trailing backslash ("\") at the end of the path 

name. Catalyst now automatically inserts a trailing backslash if none is found. 

What’s new in Catalyst 1.0.1: 
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• Fixed an issue where the Catalyst Controller failed to start on PCs with only the Catalyst Client but not the Catalyst 

Configuration Manager installed. The issue was caused by a missing or unreadable required Registry Key which is 

now properly created during first use of the Catalyst Client. 

• Fixed an issue requiring browsers referenced in projects to match browsers installed on client PCs. Catalyst now 

runs properly on systems with only Chrome and Internet Explorer or only Firefox and Internet Explorer using the 

default settings created for new projects in Catalyst Configuration Manager. 

• Fixed an issue that caused a crash in Catalyst Configuration Manager under certain conditions when rules were 

reordered. Rules can now be reordered reliably. 

• Fixed an issue where the Starting Browser appeared to hang while navigating to Internet Explorer while certain 

Windows Explorer windows were open.  
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